# Table of contents

## About this manual
- Contacting IBM Rational Software Support  ........................................... 2
- Prerequisites .................................................................................................... 2
- Submitting problems ...................................................................................... 2
- Conventions used in this guide ........................................................................ 5

## Introduction
- Obtaining the RDS software ........................................................................ 7
- Installation sequence ..................................................................................... 7
- Types of RDS installations ............................................................................. 8
- Preparing installation information ................................................................ 9
- Frequently Asked Questions ......................................................................... 9

## Server Installation
- System requirements .................................................................................... 13
  - Industry standards ...................................................................................... 13
  - Operating system requirements ................................................................ 13
  - Disk space and memory requirements ...................................................... 14
- Before installing RDS ................................................................................... 14
  - RDS 5.1 server .......................................................................................... 14
  - Installation user ......................................................................................... 14
  - What is not supported ................................................................................ 15
    - Console mode installation ...................................................................... 15
- Installing RDS .............................................................................................. 16
- Post installation instructions ......................................................................... 23
  - Starting the Web server ............................................................................. 23
  - Review log files .......................................................................................... 23

## Server Removal

---

*IBM Rational Directory Server Installation Guide*  iii
Removing the RDS ................................................................. 25

Client Installation ........................................................................... 27
Installing the RDA ................................................................. 27

Client Removal ............................................................................ 33
Removing the RDA ................................................................. 33

Launching RDA ............................................................................ 35

Troubleshooting RDS ............................................................... 37

Terms and Concepts ................................................................... 39

Appendix A: Notices ..................................................................... 41
Trademarks .................................................................................. 44

Index ........................................................................................... 45
This manual guides you through the IBM® Rational® Directory Server (RDS) installation and uninstallation.

It contains the following sections:

- Introduction
- RDS documentation
- Types of RDS installations
- Preparing installation information
- Server Installation
- Server Removal
- Client Installation
- Client Removal

RDS documentation

This section provides the information on the related documents available for RDS. The following RDS documents are available on the Product Support Website, [http://www.ibm.com/software/rational/support/](http://www.ibm.com/software/rational/support/)

<table>
<thead>
<tr>
<th>Document Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rational Directory Server Installation Guide</td>
<td>Provides information on how to install the RDS.</td>
</tr>
<tr>
<td>Rational Directory Server Product Manual</td>
<td>Provides detailed information on RDS features supported in this release.</td>
</tr>
<tr>
<td>Rational Directory Server Administration Manual</td>
<td>Provides information on RDS administration.</td>
</tr>
</tbody>
</table>
Contacting IBM Rational Software Support

If the self-help resources have not provided a resolution to your problem, you can contact IBM® Rational® Software Support for assistance in resolving product issues.

Note If you are a heritage Telelogic customer, a single reference site for all support resources is located at http://www.ibm.com/software/rational/support/telelogic/

Prerequisites

To submit your problem to IBM Rational Software Support, you must have an active Passport Advantage® software maintenance agreement. Passport Advantage is the IBM comprehensive software licensing and software maintenance (product upgrades and technical support) offering. You can enroll online in Passport Advantage from http://www.ibm.com/software/lotus/passportadvantage/howtoenroll.html

- To learn more about Passport Advantage, visit the Passport Advantage FAQs at http://www.ibm.com/software/lotus/passportadvantage/brochures_faqs_quickguides.html.
- For further assistance, contact your IBM representative.

To submit your problem online (from the IBM Web site) to IBM Rational Software Support, you must additionally:

- Be a registered user on the IBM Rational Software Support Web site. For details about registering, go to http://www.ibm.com/software/support/.
- Be listed as an authorized caller in the service request tool.

Submitting problems

To submit your problem to IBM Rational Software Support:

1. Determine the business impact of your problem. When you report a problem to IBM, you are asked to supply a severity level. Therefore, you need to understand and assess the business impact of the problem that you are reporting.
Use the following table to determine the severity level.

<table>
<thead>
<tr>
<th>Severity</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>The problem has a critical business impact: You are unable to use the program, resulting in a critical impact on operations. This condition requires an immediate solution.</td>
</tr>
<tr>
<td>2</td>
<td>This problem has a significant business impact: The program is usable, but it is severely limited.</td>
</tr>
<tr>
<td>3</td>
<td>The problem has some business impact: The program is usable, but less significant features (not critical to operations) are unavailable.</td>
</tr>
<tr>
<td>4</td>
<td>The problem has minimal business impact: The problem causes little impact on operations or a reasonable circumvention to the problem was implemented.</td>
</tr>
</tbody>
</table>

2. Describe your problem and gather background information. When describing a problem to IBM, be as specific as possible. Include all relevant background information so that IBM Rational Software Support specialists can help you solve the problem efficiently. To save time, know the answers to these questions:

- What software versions were you running when the problem occurred?
  
  To determine the exact product name and version, use the option applicable to you:
  
  - Start the IBM Installation Manager and select **File > View Installed Packages**. Expand a package group and select a package to see the package name and version number.
  
  - Start your product, and click **Help > About** to see the offering name and version number.

- What is your operating system and version number (including any service packs or patches)?

- Do you have logs, traces, and messages that are related to the problem symptoms?

- Can you recreate the problem? If so, what steps do you perform to recreate the problem?
• Did you make any changes to the system? For example, did you make changes to the hardware, operating system, networking software, or other system components?
• Are you currently using a workaround for the problem? If so, be prepared to describe the workaround when you report the problem.

3. Submit your problem to IBM Rational Software Support. You can submit your problem to IBM Rational Software Support in the following ways:

• **Online:** Go to the IBM Rational Software Support Web site at [https://www.ibm.com/software/rational/support/](https://www.ibm.com/software/rational/support/) and in the Rational support task navigator, click **Open Service Request.** Select the electronic problem reporting tool, and open a Problem Management Record (PMR), describing the problem accurately in your own words.

For more information about opening a service request, go to [http://www.ibm.com/software/support/help.html](http://www.ibm.com/software/support/help.html)

You can also open an online service request using the IBM Support Assistant. For more information, go to [http://www.ibm.com/software/support/isa/faq.html](http://www.ibm.com/software/support/isa/faq.html).

• **By phone:** For the phone number to call in your country or region, go to the IBM directory of worldwide contacts at [http://www.ibm.com/planetwide/](http://www.ibm.com/planetwide/) and click the name of your country or geographic region.

• **Through your IBM Representative:** If you cannot access IBM Rational Software Support online or by phone, contact your IBM Representative. If necessary, your IBM Representative can open a service request for you. You can find complete contact information for each country at [http://www.ibm.com/planetwide/](http://www.ibm.com/planetwide/).
## Conventions used in this guide

<table>
<thead>
<tr>
<th>Typeface</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Italic</em></td>
<td>Used for book titles and terminology.</td>
</tr>
<tr>
<td><strong>Bold</strong></td>
<td>Used for items that you can select and menu paths, also used for emphasis.</td>
</tr>
<tr>
<td><em>Courier</em></td>
<td>Used for commands, file names, and directory paths. Represents command syntax to be entered verbatim. Signifies computer output that displays on-screen.</td>
</tr>
<tr>
<td><em>Courier Italic</em></td>
<td>Represents values in a command string that you supply. For example, <em>(drive:\username\commands).</em></td>
</tr>
</tbody>
</table>
Introduction

The RDS is a single enterprise directory solution designed for user authentication and administration for IBM® Rational® Solutions for Enterprise Lifecycle Management tools. RDS allows the users to login using the same credentials across Enterprise Lifecycle Management tools for which they have authorized access.

RDS is designed to support a wide range of platforms. For more information on the platform support see Operating system requirements (page 13).

Note The RDS 5.1.0.2 should be installed on an existing RDS 5.1 server. The RDS 5.1.0.2 automatically updates both server and client. You can also install the client separately by installing the RDA.

Obtaining the RDS software

You can download the RDS from the support site or from the zip distribution. After downloading the RDS, make sure you verify the MD5 checksum available under the support site, http://www.ibm.com/support/fixcentral/ matches the downloaded installer. This will ensure that the downloaded installer is not corrupted.

Installation sequence

The RDS must be present in the system for the other tools to connect. You can install the RDS prior to or post other tools installation.
### Types of RDS installations

The RDS provides two types of installations:

<table>
<thead>
<tr>
<th>Installation type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server Installation</td>
<td>Installs RDS 5.1.0.2 fix pack on an existing RDS 5.1 server. The RDS provides user authentication and administration across Enterprise Lifecycle Management tools using the same credentials.</td>
</tr>
<tr>
<td>Client Installation</td>
<td>Installs the client (RDA) on a local machine. The client can access the server on the local machine or on a network.</td>
</tr>
</tbody>
</table>
Preparing installation information

Preparing installation information in advance can help you to complete the installation process quickly. Before starting the installation, consider creating a worksheet to hold the basic installation information, as described for a typical installation in the following table.

<table>
<thead>
<tr>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host Name</td>
<td>Same as your existing RDS 5.1 server.</td>
</tr>
<tr>
<td>Directory Server port number</td>
<td>Default LDAP port. Use the same port number</td>
</tr>
<tr>
<td></td>
<td>given at the time of RDS 5.1 installation.</td>
</tr>
<tr>
<td>Secure port number</td>
<td>(Default LDAP SSL port. Use the same secure</td>
</tr>
<tr>
<td></td>
<td>port number given at the time of RDS 5.1</td>
</tr>
<tr>
<td></td>
<td>installation.</td>
</tr>
<tr>
<td>Directory Administrator password</td>
<td>tdsadmin user password set at the time of</td>
</tr>
<tr>
<td></td>
<td>RDS 5.1 installation.</td>
</tr>
<tr>
<td>Directory Administrator ID</td>
<td>tdsadmin (set by default)</td>
</tr>
<tr>
<td>Installation Directory</td>
<td>Same as your existing RDS 5.1 server. For</td>
</tr>
<tr>
<td></td>
<td>example, C:\Program Files\IBM\Rational\RDS_5.1</td>
</tr>
</tbody>
</table>

Frequently Asked Questions

1. *Which are the external LDAP servers supported by RDS?*

   Sun Java (tm) System Directory Server and Microsoft (t) Active Directory Server.

2. *What is the schema required by RDS in the external corporate server?*

   The user information are extracted from the corporate servers based on the person/inetOrgPerson schema class and the primary attributes cn, sn, email, uid, givenname, telephoneNumber, mail, facsimileTelephoneNumber, description, postalAddress, and sAMAccountName.

   The group information are extracted based on the group/ groupOfUniqueNames schema class and the attributes member/ uniqueMember, description.
3. Do we need an Administrator privileges to create a partition?

You need a corporate LDAP server user with a Read access to the search bases specified in the partition.

4. I cannot use RDA on Solaris to create a partition with SSL enabled?

This is a known limitation. You need to install RDA on Windows as a workaround.

5. Why DOORS do not show up a user after changing the name of the user from one ou to another in the corporate LDAP?

If the name of a user (firstname, lastname, cn etc.) is changed keeping the same UID, or if a user is moved from one OU to another in the corporate LDAP, DOORS may not show up the user. The reason is, the RDS has already created an extended user object with the uid as the user logon name (based on the logon attribute selected in the corporate partition) and tdsCorporateDn as the corporate DN of the user. If the corporate DN of the user changes in the corporate LDAP server, RDS will try to recreate the extended user object with the same user logon name (which is not changed in corporate LDAP) and would fail, as the user object with the same logon name already exists in the corporate LDAP. Hence, the particular user would not be shown in DOORS.

To solve this issue, it is recommended to modify the required attributes of the extended user object in RDS. Deleting the extended user object also solves the issue but it may delete the DOORS specific values for that user object, which may lead to information loss.

6. Will error opening *.cat files messages affect functionalty of RDS 5.1 for Tivoli in anyway?

No. You can ignore such error messages, they keep coming because of a minor localization issue with Tivoli which will no way affect RDS and its functionalities.

7. Is RDS supported on VMWare?

Currently, the RDS is not supported on a virtual environment.
8. How do you change the Webserver port from 8080 to any other values for IBM Rational Directory Administration (RDA)?

To change the default port number:

a. Edit the following lines in the Server.xml file located under:
   `<RDS_HOME/RDA_HOME>\WebAccessServer\apache-tomcat-6.0.16 (-6.0.24 for 5.1.0.1 and 5.1.0.2)\conf` folder:

   ```xml
   Connector port="8090" protocol="HTTP/1.1"
   connectionTimeout="20000"
   redirectPort="8443" /
   <!-- A "Connector" using the shared thread pool-->
   ```

b. Restart the RDA for the changes to take effect.

   **Note** The new port number is changed to 8090 in the above example.
3 Server Installation

This chapter contains the installation instructions for installing RDS on a Windows platform.

This chapter contains the following sections:

- System requirements
- Before installing RDS
- Installing RDS
- Post installation instructions

System requirements

The following section includes the system requirements for the RDS.

Industry standards

The RDS is developed based on the following industry standards.

- LDAP v3 operations
- LDAP search filters
- LDAP v3 intelligent referral

Operating system requirements

The RDS is supported on the following platforms:

- Microsoft Windows Server 2003 Standard, Enterprise Edition (SP1 and R2)
- Microsoft Windows XP SP2
- Microsoft Windows Vista

The RDA is supported on the following platforms:

- Microsoft Windows XP SP2
- Microsoft Windows Vista
Chapter 3: Server Installation

Disk space and memory requirements

Requirements for RDA

Ensure that sufficient disk space is available before installing the RDA. The following table shows the minimum disk space requirement for RDA.

<table>
<thead>
<tr>
<th>Minimum disk space required</th>
<th>Minimum memory required</th>
</tr>
</thead>
<tbody>
<tr>
<td>300 MB</td>
<td>512 MB RAM (/ and a 350MHz Pentium processor for Windows.</td>
</tr>
</tbody>
</table>

Before installing RDS

Before you install the RDS, ensure that the system is equipped with the set of configurations recommended in this manual to avoid any installation errors. You must have at least 2 GB of free disk space and at least 1 GB free space in %TEMP% folder.

This section describes the following settings that must be in place.

- RDS 5.1 server
- Installation user
- What is not supported

RDS 5.1 server

Make sure that the RDS 5.1 is present and running in your system before installing the RDS 5.1.0.2. However, it is recommended to stop the Web access server (RDA) during installation.

Installation user

The RDS installation should be done by the local administrator i.e the Administrator account of Windows operating system.
Before installing RDS

What is not supported

This section describes the modes or systems that are not supported by RDS. You must not use the modes or systems referred in this section to avoid any installation errors.

Console mode installation

The RDS does not support non-graphical or console mode installation. Hence, the options such as `-console` must not be used at the time of installation.
Installing RDS

This section provides you the installation steps for RDS. Follow these steps after completing the Tivoli installation detailed in the previous section.

To start the RDS installation, first unzip the RDS installer in a folder using the WinZip utility. Then, follow the RDS installation procedures given below.

You can go backward or forward at any time during the installation to change options.

To abort the installation, click Cancel.

To Install RDS on Windows:

1. Open the <RDS Image>\Install folder and double-click the RDS.exe. The Introduction dialog box appears.

2. Click Next. The License Agreement dialog box is displayed.

3. You can save the licence details in a document.

   To copy the license information:
   • Right click on the licence window and click Select All, and then click Copy.
   • Open any file, paste the license information and save the file.
4. Review and click **I accept the terms of the license agreement.**
5. Click **Next**.

The **Tivoli Home Folder** dialog box is displayed.

6. Click **Choose** to specify the directory path where you have installed Tivoli. You can also type the path manually by clicking anywhere in the text box.
7. Click Next. The **Rational Directory Server Configuration** dialog box is displayed. This defines the configuration settings for RDS.

8. Type the directory server configuration properties.

The field description and the value to be entered in each field is explained in the following table.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host Name</td>
<td>The host name of the computer where RDS 5.1 installed.</td>
<td>Enter a computer name where the RDS 5.1 is installed.</td>
</tr>
<tr>
<td>Directory Server Port</td>
<td>The port number of the RDS 5.1.</td>
<td>Enter the RDS 5.1 directory server port number.</td>
</tr>
</tbody>
</table>
Chapter 3: Server Installation

9. Click **Next**.

10. Type the **Directory Administrator User** password.

   This should be the same password set at the time of Tivoli Directory Server installation.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Secure Port</td>
<td>The LDAP Secure Socket Layer (SSL) port number. By default, the SSL is enabled by the installer using the secure port number provided during the installation.</td>
<td>Enter the RDS 5.1 secure port number in this field.</td>
</tr>
</tbody>
</table>
The field description and the value to be entered in each field is explained in the following table:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rational Directory Server Administrator</td>
<td>The admin user for the RDS.</td>
<td>The RDS administrator ID is set by default. The administrator ID cannot be modified.</td>
</tr>
<tr>
<td>Administrator Password</td>
<td>The password for RDS admin user.</td>
<td>Type the tdadmin user password given at the time of Tivoli installation.</td>
</tr>
<tr>
<td>Confirm Password</td>
<td>This describes the password authentication for the RDS admin user.</td>
<td>Re-enter the password in this field. Both passwords should match for the installation to continue.</td>
</tr>
</tbody>
</table>

11. Click Next. The Pre-Installation Summary dialog box displayed. This dialog box shows the installation summary.

12. Review the information, and then click Install.

The Install Complete dialog box is displayed if the installation is successful.
13. Click Done to exit the installer.
Post installation instructions

This section details the basic checks that you can perform to ensure that the installation has gone through fine.

This section contains the following components:

- Starting the Web server
- Review log files

Starting the Web server

After installing RDS, start the Web server using the following command:

\<RDS_Install_Dir\\WebAccessServer\Start_RDAWebServer.bat

For example:

C:\Program Files\IBM\Rational\RDS_5.1\WebAccessServer\Start_RDAWebServer.bat

After starting the server, login to RDS, click Help > About and confirm that the client and server version values have changed to 5.1.0.2.

Review log files

1. If the installation is corrupted and the server is not started, review the following log files carefully for any errors.
   - \<RDS_InstallHome\\RDS_5.1.0.2_InstallLog.log
   - \<RDS_InstallHome\\logs\ modify_5.1.0.2.log
   - \<RDS_InstallHome\\logs\schema-error_5.1.0.2.log

2. If the log files specify the installation has failed with Tivoli or DB2 errors, look for the server startup errors in ibmslapd.log.

Note The above listed log files must be sent along with other relevant information to the support specialist while reporting the errors. For more information on reporting the errors, see Contacting IBM Rational Software Support (page 2).
Server Removal

Removing the RDS

This chapter describes the steps to remove RDS and Tivoli servers. Remove the server with the same user account that was used for installation. You must remove RDS first and then the Tivoli Directory Server.

**Note** Removing the IBM Tivoli Directory Server also removes the IBM DB2.

There is no separate uninstaller for RDS 5.1.0.2. Use the RDS 5.1 uninstaller to uninstall the RDS.

To remove RDS, do the following:

1. Stop the **RDS Web Access Server** by pressing the **CTRL+C** key on the Web Access Server startup console.

2. Remove RDS using one of the options:
   - Use **Add/Remove Programs** in the Windows Control Panel to remove RDS.
   - Double-clicking the **UninstallRDS 5.1.exe** from the path `<RDS_Install_Dir>/UninstallRDS5.1`. The **Uninstall RDS 5.1** dialog box appears.

3. Click **Uninstall** to remove the RDS.

4. The **Uninstaller** removes the components one by one.

5. After removing all the components successfully, the **Uninstall Complete** dialog box is displayed.

6. Click **Done** to exit the installer.

7. Click **Yes** on the message box to restart the system.
IBM® Rational® Directory Administration (RDA) is a GUI based client application used to perform day-to-day administration tasks such as creating users, groups, roles, performing searches, migrating data, etc.

RDA is available as a web-based tool that you can access using a browser.

**Installing the RDA**

This chapter describes the steps required to install RDA. To start the installation, first unzip the RDA installer in a folder using the WinZip utility. Then, follow the installation procedure below.

To install RDA do the following:

1. Open the `<RDA Image>\Install` folder and double-click the `RDA.exe`. The **Introduction** dialog box is displayed.
Chapter 5: Client Installation

2. Click Next. The **License Agreement** dialog box is displayed.

3. You can also save the licence details in a document.
   
   To copy the license information do the following:
   
   - Right click on the license window and click **Select All**, and then click **Copy**.
   - Open any file, paste the license information and save the file.

4. Review and click **I accept the terms of the license agreement**.
5. Click **Next**. The **Choose Install Folder** dialog box is displayed.

You can use the default location provided by the installer or click **Choose** to specify a different location. You can also edit the path manually by clicking anywhere in the text box. To use the default location, click **Restore Default Folder**. This restores the default location provided by the installer.
Chapter 5: Client Installation

6. Click **Next**. The **Desktop Shortcut** dialog box is displayed. By default, the **Create a shortcut to RDA on the desktop** option is checked. Click to clear the check box if you do not want the shortcut to be created.
7. Click **Next**. The **Pre-Installation Summary** dialog box is displayed. This dialog box displays the installation summary.

8. Review the information and click **Install**.

The **Install Complete** dialog box is displayed if the installation is successful.
9. Click **Done** to exit the installer.

**Note**  After installing the RDA, **start** the Web server using the following batch script:

```
<RDA_Install_Dir>\WebAccessServer\Start_RDAServer.bat
```
6

Client Removal

Removing the RDA

This chapter describes the steps required to remove RDA.

To uninstall RDA, do the following:

1. Stop the RDS Web Access Server by pressing the CTRL+C key on the Web Access Server startup console.
2. Remove RDA using one of the options:
   - Use the Add/Remove Programs from the Control Panel to remove the RDA.
   - Double-click Uninstall RDA 5.1.0.2.exe from the path <RDA_Install_Dir>/UninstallRDA5.1.0.2. The Uninstall RDA 5.1.0.2 dialog box appears.
3. Click Uninstall to remove RDA.
4. The Uninstaller removes the components one by one. The Uninstall Complete dialog box appears if the uninstallation is successful.
5. Click Done to exit the installer.
Launching RDA

This chapter describes how to launch the RDA application.
You can launch RDA from any machine by providing the appropriate URL. The Web RDA is supported on Internet Explorer and Mozilla browsers.

**Note**  The RDA web server starts automatically during installation.

To start the RDA, do the following:

1. If the RDA web server is not started automatically, run the following command to **start** the web server.
   ```
   <RDA_Install_Dir>\WebAccessServer\Start_RDAWebServer.bat
   ```
   For example:
   ```
   C:\Program Files\IBM\Rational\RDA_5.1.0.2\WebAccessServer\Start_RDAWebServer.bat
   ```

2. Open the browser and type the following URL
   ```
   http://<hostname>:8080/webrda/rda
   ```
   For example:
   ```
   http://rdsserver:8080/webrda/rda
   ```
   **Note**  The `<hostname>` refers to the name of the server where the RDS is installed.

3. The **RDS Login** dialog box is displayed.
4. On the **Login** dialog box, type the details as:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>RDS URL</strong></td>
<td>The LDAP URL should include a valid server name and a port number that was given at the time of RDS installation. For example: <code>ldap://dirserv:1636</code>. To open the RDS in secure mode, you can include the letter &quot;s&quot; to the <code>ldap</code> URL (where the &quot;s&quot; refers to the secure port), followed by a valid server name and a port number. For example: <code>ldaps://dirserv:1636</code>.</td>
</tr>
<tr>
<td><strong>RDS Admin</strong></td>
<td>The admin user name for RDS. The admin user <code>tdsadmin</code> is set by the RDS installer.</td>
</tr>
<tr>
<td><strong>Password</strong></td>
<td>The admin user password set at the time of RDS installation.</td>
</tr>
</tbody>
</table>

5. Click **Login**.
Troubleshooting RDS

This chapter describes the possible problem and solutions for RDS users.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installation was successful but server version is shown as 5.1.</td>
<td>Check the following logs  &lt;RDS_InstallHome&gt;/logs/modify_5.1.0.2.log  &lt;RDS_InstallHome&gt;/logs/schema-error_5.1.0.2.log and make sure that all schema updates were successful. If there are any errors, it is possible that either the RDS 5.1 server was not running at the time of installation or an invalid tdsadmin credentials were given at the time installation.  Re-install the RDS 5.1.0.2 after starting the RDS 5.1 server and provide valid password for the tdsadmin user.</td>
</tr>
</tbody>
</table>
## Terms and Concepts

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>OS authentication</td>
<td>Operating system authentication is the process of proving the identity of the client user to the Directory Server based on the operating system logon name.</td>
</tr>
<tr>
<td>SSL</td>
<td>Secure Sockets Layer. SSL is a software library establishing a secure connection between client and server.</td>
</tr>
<tr>
<td>RDS Client</td>
<td>A RDS client is a interface that requests services or information from a server.</td>
</tr>
</tbody>
</table>
Appendix: Notices

© Copyright 2000, 2010

U.S. Government Users Restricted Rights - Use, duplication, or disclosure restricted by GSA ADP Schedule Contract with IBM Corp.

This information was developed for products and services offered in the U.S.A. IBM may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information on the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user’s responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not grant you any license to these patents. You can send written license inquiries to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte character set (DBCS) information, contact the IBM Intellectual Property Department in your country or send written inquiries to:

IBM World Trade Asia Corporation
Licensing
2-31 Roppongi 3-chome, Minato-ku
 Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other country where such provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.
Some states do not allow disclaimer of express or implied warranties in certain transactions. Therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of information between independently created programs and other programs (including this one) and (ii) the mutual use of the information which has been exchanged, should contact:

Intellectual Property Dept. for Rational Software
IBM Corporation
1 Rogers Street
Cambridge, Massachusetts 02142
U.S.A.

Such information may be available, subject to appropriate terms and conditions, including in some cases, payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the results obtained in other operating environments may vary significantly. Some measurements may have been made on development-level systems and there is no guarantee that these measurements will be the same on generally available systems. Furthermore, some measurements may have been estimated through extrapolation. Actual results may vary. Users of this document should verify the applicable data for their specific environment.
Information concerning non-IBM products was obtained from the suppliers of those products, their published announcements or other publicly available sources. IBM has not tested those products and cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those products.

This information contains examples of data and reports used in daily business operations. To illustrate them as completely as possible, the examples include the names of individuals, companies, brands, and products. All of these names are fictitious and any similarity to the names and addresses used by an actual business enterprise is entirely coincidental.

If you are viewing this information softcopy, the photographs and color illustrations may not appear.
Trademarks

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of International Business Machines Corp., registered in many jurisdictions worldwide. Other product and service names might be trademarks of IBM or other companies. A current list of IBM trademarks is available on the Web at www.ibm.com/legal/copytrade.html.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the United States, other countries, or both.
Java and all Java-based trademarks and logos are trademarks of Sun
Other company, product or service names may be trademarks or service marks of others.